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3. ITL SOFTWARE SUPPORT GUIDE

3.1 Validator Manager Software

Validator Manager (also called Bank Note Validator Currency Manager) is a software
package developed by Innovative Technology Ltd to allow customers to carry out
programming, setup and operational tasks on the NV10 USB bank note validator.

3.1.1 Preparing for Installation
If you do not have the Validator Manager software, you can easily download it from

the Innovative Technology website. Visit www.innovative-technology.co.uk, and select
‘Software Download’ from the ‘Support’ tab:

(all: +44 (0) 161626 9999

o
tlnnovative Technology INTELLIGENCE IN VALIDATION Search Here

ZE m

= o
HOME  PRODUCTS ~ SMARTDATA  SUPPORT  ABOUTUS  NEWS&EVENTS  CAREERS  CONTACTUS  SHOP If T .

Products Support (areers

- LW
innovative-technol uk/support/s X A é ‘I(.ﬁ'\ g{‘&v |

Clicking this link will take you to the software download page. To download any files
you must log in as a registered user — if you have not already registered this is a very
quick process; just click Register - Create an account and follow the on-screen
instructions.
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Username

Password

Remembe

Laogin |

» Forgot your password?
« Forgot your username?
» Create an account

To download a software file you must first login.
MB: All users must re-register with the new site.

Enter your login
details here, or
create a new
account

Always ensure you are using the most up-to-date software
befare altering any firrmware or currency dataset files.

Latest Datasets

UGX02602 (NYZ00)
UGX01603 (NYZ00)
CRCO1602 (NY200)
ISK0110100 (Mv10)
MYRO1203 (BY20)
IDRO2602 (NYZ00)
IDRO1603 (NYZ00)

Title Wersion File THBO1602 (Nv¥z00)
Bank Mote Validator Gurrency Manager 3313 1] K2T01602 (NV200)
VP S (Validator Programming System) 1.0.16 7] LYLO1603 (HvZ00)
SMART PIPS (Pay In Pay Out Systern) 1.45 @
Bank Mote Yalidator Diagnostics Tools 1.04 @
DAZ Drivers - 32 bit (]
D2 Drrivers - 64 bit 1 @
BY Interface Driver Install - 32 hit 2 @
BY Intatface Driver Install - B4bit 1 @
Mva Currency Manager 283 @

After logging in, the download screen will change slightly:

Your user name will be displayed in
the top right hand corner of the &
screen Hi

The padlock icon for each file will - =
change from locked to unlocked. To =
download a file, just click on the

padlock icon opposite the file name.

If you want to find more information

about the file before you download @
it, you can click on the blue

information icon.
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In this case, we want to download the Validator Manager software, so we click on the
padlock icon opposite the ‘Bank Note Validator Currency Manager’ filename:

Title Yersion File

—> Bank Mote Walidator Currency Manager 3313 @ )
YRS Malidator Programming System) 1.0.16 @ ﬁ_h
SMART PIPS (Pay In Pay Out Systen 1.4.4 @
Bank Mote Yalidator Diagnostics Tools 1.0.4 @
DA2 Drivers - 32 hit o
DA2 Drivers - B4 hit 1 ()]
B Interface Driver Install - 32 bit 2 o
BY Interface Driver Install - G4 hit 1 ()]
M4 Currency Manager 2583 @

After clicking the link, a file download dialog box will appear — choose the option to
save the file:

File Download |
Do you want to open or save this file?

@ Mame: “alidatorbdanager 33 13 maizip
Type: WinRAR ZIP archive

From:  www_innovative-technology co_uk

Cpen | Save | Cancel I
3

l--' . whhile files fram the Internet can be useful, some files can potentially
@ harm your computer. If wou do nat tust the zource, do not open or
zave thiz file. "wWhat's the nzk?

You can save the file anywhere that is convenient, as long as you can remember
where it is when you want to install the software.
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Save As 2] %
Save in: I@Desktnp EIGEE

'j by Computer

n by Documents
L My Network Places

Dezkiop

by Documents

File name: '-.-".aliu:latn:nrr-.-iar‘uan:ler 3313 ma j Save
Saveastype:  |WinRAR ZIP archive - Cancel |
]

After choosing where to save the file, a file transfer dialog box will appear showing
the progress of the file download:

555KEB of __orManager®203_3 13 msi zip from www. innoyat.__ !E[

~

..ofitanager®203 3 13 meaizip from s innosative-technology, co.uk

Eztimated time left: Mat known [Opened =0 far B55EE]
Dowrload o C:ADocw,. \Walidatorbanager 33 1.3_msizip
Tranzfer rate: ohaKESec

¥ Close this dislog box when download completes

[N Een e Eolder | | Cancel I

threatz. Beport an unzafe download.

@I SmartScreen Filter checked thiz download and did not repart ang
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3.1.2 BV Interface Drivers

After downloading the Validator Manager software, you will also need to download the
Banknote Validator (BV) Interface drivers — two versions are available (32 bit and 64
bit) so choose the correct type for your operating system. Again, remember where
you saved the file.

File Download I

Do you want to open or zave this hle?

E Mame: 32bit_BYInterface_Drivers_zip.zip
Tupe: WinRAR ZIF archive

From: www_innovative-technology. co.uk

Open Save | Cancel I

harm your computer. [F you do not trust the source, do not open or

l@ Wwhile filez from the Internet can be useful, some files can potentially
zave this file. What's the rizk?

Both files are provided in a ‘zipped’ (compressed) form — you will need to extract the
files from the zipped file before you can install the software or driver. Any version of
Windows from Windows 98 onwards can open zipped files; or you may want to use a
third party software tool such as Winzip or WinRAR.

@& 32bit_BVInterface_Drivers P ]
File Edit View Favortes Tool:  Help | :fl
= & - )
Add a Password... - Search H_.'-- Folders |[/Ep | & x n |
[Ereate SHnTet x @
Delete
Rename tusbdevice  itlusbdevice

Fropertiez

32bit_BWInterface_Drivers »

Close

A — T = B 1 R
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Extract the files to a convenient location — this might be an existing folder, or you may
want to save them into a new folder.

E xtraction Wizard

Welcome to the
Compressed (zipped)
Folders Extraction
Wizard

The extraction wizard helps pou copy files
from inzide a ZIF archive.

To continue, chck Mext,

¢ Bach I Mewt I Cancel |

In this example, the BV Interface driver files are being saved into a folder called
‘Drivers’ on the computers C: drive.

Extraction Wizard Bl |
Select a Destination o
Filez inzide the ZIF archive will be extracted to the location wou
chooze,

Select a folder to extract files to.

Filez will be extracted to this directon:

IE:'\Driverd
Browsze. .. |
Pagzzword... |

Extracting...

< Back I Meut = I Cancel
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Extraction Complete e
Filez have been succeszsfully extracted from the ZIP archive.

Extraction Wizard

Filez have been succeszsfully extracted to the fallowing
directony:

C:ADirivers

To zee vour extracted filez, check the box below:

¥ Show estracted files

Press finizh bo continue.

< Blach Fir&fh Cancel

& Drivers = [=1E3|

File Edit ‘iew Favortes Tools Help |

Q-0 3 5 0 X 9|

— e itushdevice ituzbdevice
= Setup Information
= KB

=

/':_j Search L Folders

Syzten file
55 KB
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3.1.3 Installing the Drivers

There are several ways to communicate with the NV10 USB validator, which include
using a direct connection from computer to validator with a CN392 ITL to USB cable,
or by using a DA2 programming kit. Use of the DA2 is not covered here — please refer
to ITL Document number GA338-2 for more information. In this manual we will be
using the USB connection method.

To use a USB connection with the NV10 USB, a USB cable with a 16 way connector on
one end (ITL Part Number CN392) should be used. The CN392 cable fits into the 16
way connector and allows high speed programming and serial communications when
used in SSP, ccTalk and SIO modes. When using the USB connection, power must be
supplied to the NV10 USB using the red and black power leads on the CN392 cable.

The connector used to set up and interface with the NV10 USB Validator is easily
accessible on the side of the unit:

Interface
Connector

The NV10 USB validator must be powered up for the interface to be recognised by
Windows. If the validator is not in the host machine, you will need to provide power
to the 16 way interface connector first. The connection information and pin numbering
is as follows:

. 15 Pin Description
] 1 Serial Data Out (Tx)
5 Serial Data In (Rx)
ONOHEORONOROROE®, 11 USB Data +
12 USB Data -
e 13 USB Power (+5V)
15 +V
2 16 16 0V / Ground Connection

Copyright © Innovative Technology Ltd 2014 t GA450-4



NV10 USB Manual Set — Section 3 11

Before connecting the USB cable to the computer, make sure that the CN392 cable is
connected to the validator and that the unit is powered up. Once you have carried out
these steps, plug the USB cable into the computer.

After connecting the USB cable, Windows

should then detect the NV10 USB i) Found New Hardware x|

validator interface — a ‘Found New BY Interface

Hardware’ bubble or dialog box should —

appear. = O] M NS T ND B 0305

A ‘Found New Hardware’ wizard should then start to guide you through the installation
process (this first screen is not always shown on some computers):

Found Mew Hardware Wizard

Welcome to the Found New
hil\ Hardware Wizard
&

Windows will search for current and updated software by
looking on your computer, an the hardware installation CD. or on
the "Windows Update 'Web zite [with your permizsion).

Fead our privacy policy

Can Windows connect to Windows Update to search for
zoftware?

0 Yes, this time anly
™ Yes, now and every time | connect a device
& Mo, not thig time

Select this option
as you already
have the drivers

Click Mest to continue.

< Elacl I et » I Cancel

0 . Please make sure that you are using the V2 drivers

Only use V2 drivers for the installation.
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F

ound New Hardware Wizard

5

Thiz wizard helps you install software faor:

ITL BY Serial W2

or floppy disk, insert it now.

“What do pou want the wizard to da?

7 Inztall the software automatically (R

& Imztall from a list or specific locati

Click Mext to continue.

:'\-J| If your hardware came with an instal

[hdvanced)

12

location

Select this option as
we have saved the
drivers to a known

< Back I [ewt » I Cancel

The next dialog box will ask you where to search for the drivers:

Found New Hardware Wizard

Please choose your search and installation options.

& Search for the best diver in these locations,

Ilze the check boxes below to limit or expand the default search, wh
paths and removable media. The best driver found will be installed.

V¥ Search remavable media [floppy, CO-ROM...]

Click the ‘Browse’
button to find the
driver files (in this
example C:\Drivers)

W Include this location in the search:

C:APEOGHRAM FILES WY,

" Daon't gearch. | will chaose the driver b install,

Chooze thiz option to select the device driver fram a list. Windows does not quarantee that

the driver you choosze will be the best match for pour hardware.

< Back I Mest » I Cancel

Copyright © Innovative Technology Ltd 2014 t
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Browse For Folder Kl

Select the Falder that contains drivers Far waur hardware,

= j by Computer =
= e WwirsP [T
I3 col5319
I3 Documents and Settings
Diriver
I Progran Files
I WINDOWS
e Data (0]
= EAM [E:]
it MPSEME [F)
“o Removable Dizk [G:]
“# Removable Dizk [H:] =l

To wiew any subfolders, click a plus sign above,

0 Cancel |

e

Found Mew Hardware Wizard

Please choose your search and installation options.

% Search for the best driver in these locations.

Uncheck this option
to speed up the
installation

|lze the check boxes below to limit or expand the defaulk
pathz and remoyvable media. The best driver found wi

[ Search removable media [floppy, CO-ROM..]

W |nclude this location in the search;

IE:HDrivers j Browsze |

= Dan't zearch. | will chooze the driver to install.

Choose this option to select the device driver from a list. Windd  Click the ‘Next’ 3
the driver you chooge will be the best match for pour hardware, button to install

the drivers

A

¢ Back Meut > Cancel |
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You may see a warning dialog saying that the drivers have not passed Windows logo
testing — you can ignore this warning. Just click the ‘Continue Anyway’ button.

Hardware Inztallation |

L4 "_l., T he =aoftware you are installing for thiz hardware;
L
ITL B Serial W2

haz not pazzed Windows Logo testing to werify its compatibility
with YWindaws =P, [Tel me who this testing i irmporkank. |

Continuing your installation of thiz zoftware may impair
or destabilize the correct operation of your spstem
either immediately or in the future. Microzoft strongly
recommends that you stop this installation now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo testing.

Continue Anpuway STOP Inztallation I

Found Hew Hardware ‘Wiza

Pleaze wait while the wizard installs the software...

(3 ITL B Serial W2

< Hach [ et [Eamze]
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Found New Hardware Wizard

5

Click, Finizh to cloge the wizard,

Completing the Found New
Hardware Wizard

The wizard haz finished installing the software for:

(3 ITL BY Serial W2

Click the ‘Finish’
button to complete
the installation

/

< Back

Finizh I [Eatize]

Copyright © Innovative Technology Ltd 2014 t
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After completing the driver installation you can check that the communications port
has been installed correctly.

Open Windows Device Manager, and click on the Plus symbol (+) next to the ‘Ports’
entry. This will expand the list of installed communications ports. You should see an
entry for an ‘ITL BV Serial V2’ port as shown here:

&, Device Manager i =]
File Action “iew Help

o [ & RE A

- t:_ B atteries
- f Computer

2o Digk diives P .
@ Display adapters ‘a Dther devices

Fl-. b DVD/CD-ROM dives EIFE-i Ports (COM & LPT)

[+ IDE ATAMTAPI controllers . (#i‘ ITL BY Serial ¥2 {COMS)
- Keyboards

' [+]-%88 Processors

- 1) Mice and ather pointing devices
& Monitors
E W etwnk ad=
T Other devices
= Ports [COM & LPT)
e S ITLBY Serial V2 (COMS)
& # Processar
-:..-n Storage wolurmes
g System devices

B~ Univerzal Serial Bus controllers

aTame controllers

The actual communications port number (in our example COM5) may vary depending
on your particular computer configuration.

Now the drivers have been correctly installed you can install the Validator Manager
software — this is covered next.

Copyright © Innovative Technology Ltd 2014 t GA450-4
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3.1.4 Installing the Validator Manager Software

Installing the Validator Manager software is very straightforward. Find the Validator
Manager zip file you downloaded earlier, extract the installation file from the zip file
and double click the extracted file (it has an .msi extension) — this will start the
installation process:

i'i!rl' YalidatorM anager

Welcome 1o the ValidatorManager Setup
Wizard

The inztaller will quide you through the steps required to install W alidatorkd anager on your
computer.

Click "Mext" to continue.

WARMIMNG: This computer pragram is protected by copyright law and intermational treatiss.
Unauthorized duplication or digtribution of this program, or any portioh of it, may result in severe
civil or criminal penaltiez, and will be prosecuted to the maximunm extent poszible under the law.

Cancel | Ereyious | [ et I

i'i!rl' YalidatorM anager

Select Installation Folder

The inztaller will inztall % alidatorkd anager in the following folder.

Toinstall in this folder, click "Mext”. To install to a different new or existing folder, enter one
below or click "Browse".

Folder: C:\Program Files'W alidatorkd anagerh Browsze. .. |

You can install the sofbware an the following drives:

Yalume | Digk. g
= 7
=D 3k
T~ | y

Dizk Cost...

Cancel | Prewvious | et I

L
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You can choose where you would like to install the software, or just accept the default
location (as shown above). Clicking on the ‘Next’ button will then ask you to confirm

the installation:

j' YalhdatorManager

| =
itz YalidatorM anager

Installing ValidatorManager

Copyright © Innovative Technology Ltd 2014 k GA450-4
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i'm‘!:l‘ ValidatorManager

Installation Complete

W alidatarkd anager haz been suceszsfully installed.

Click "Cloze" to exit.

[Eancel | Erevious | Cloze I

Once the installation is complete, you will have a new program group called ‘ITL
Validator Manager’ in the Windows Start Menu, similar to the one shown here:

@ Windaows Media Player

Turn Off Computer...

Frograms 4 rﬁ ITL " alidator b anager Shortcut to Y alidatorkd anager. exe
_;‘ Docurments r
Settingz r
i ‘,_) Search »
E Q} Help and Support
& =] Run..
=
.E ] Logoi
H 9

You can run the Validator Manager software by clicking the ‘Shortcut to
ValidatorManager.exe’ menu entry; however, before you can use the Validator
Manager software with an NV10 USB validator you will need to make sure that you
have installed the BV interface drivers (as described earlier).

Copyright © Innovative Technology Ltd 2014 t GA450-4
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3.1.5 Starting the Validator Manager Software

The Validator Manager software is launched by clicking the *Shortcut to
ValidatorManager.exe’ entry in the ‘ITL Validator Manager’ menu group.

@ YWindows Media Player l
Programs 4 B 1TL " alidator Manager Shortcut to Y alidatork anager. exe

Documents

Settingz r

Search k

Run...

Log Off

e
=
e,
@) Help and Support
7
2
©]

Windows XP Home Edition

Turn Off Camputer...

The initial program screen looks like this:

Innavative Technology Lid  Validator Manager  Version 3.3.13
Fie Took Help

=4 v B2

[COMS [55P addiess0 | 12/05/2011 [10:30

Make sure that the NV10 USB Validator is powered up and the USB cable is connected
before going any further. All of the program options can be accessed from the menu
bar at the top of the screen — some specific functions can also be accessed by clicking
the relevant icon underneath the menu bar, and the function of each icon is indicated
by a “tooltip’ indicator.
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Please be aware that not all the program options are applicable to the NV10 USB, as
the Validator Manager Software is designed to work with a range of ITL Technology
validators.

Innovative Technology Ltd  Yalidator Manager Yerzion 3.3.13

Filz | Tool: Help

=1 . Check Mates

cotalk check

O ptions

Set Walidator Ophions

Diannostics These three options are not
d used with the NV10 USB

Set MYE MagHead Type validator.

MY 200 Bezel

&55P Optionz

Full details of all the Validator Manager Software functions are detailed in the program
help file (accessible from the ‘Help” menu).

Options:

Innovative Technology Ltd  Yalidator Manager Yerzion 3.3.13

The general preferences  File | Teals Help
for the Validator = . Check Notes
Manager Software are cotalk check
accessible from the
‘Tools" menu (as )
shown)_ Click the Set Walidator Options
‘Options’ entry to open a Demrosits

new dialog box:

Set MY3 Mag Head Type

MHW200 Bezel

£55F Optionz

Selecting the ‘Serial Port’ tab from the ‘Options’ dialog and defining which serial port
to use to connect to the NV10 USB validator should be one of the first things you do
after installing the software.
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The Validator Manager will not work if the serial port is not set or is set incorrectly (if
the serial port has not been set a dialog box will appear will appear when you run the
program prompting you to enter or correct the port setting):

Yalidator Manager l

L] ": Pleaze zelect a valid COM port ar check your connectionz to the target.
L]

T |

[ £SSP Key )
f cotalk Key T Language T
Senal Port T Slave Addressz ]

Click this arrow and then click on the
port you want to select as the default
from the drop down list.

(] I Cancel

Select the correct serial port from the list and click the *OK’ button to confirm the
setting.

Copyright © Innovative Technology Ltd 2014 t GA450-4
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Check Notes:

Validation Check - 55P x|

 Channel Data |

Channel | Y alue | Mum Motes | I

Channel 1 5 i / A summary of

Channel 2 10 I accepted notes by

Channel 3 20 1} channel

Channel 4 50 0 (denomination) is
shown here.

— Channel indication Enable or disable a

l l l l channel by clicking the
:I respective button.
1 2 3 4

[T Enable log file

 EnableE q A command and response
nable £ 2Crow mode

summary is shown here.

| CMD> POLL oK
Shart-up | Stop | Cloze |
| Master: @  Slave @ | NS 03,33 13 390 00 | ELUROZB04

The ‘Check Notes’ menu item provides a way to check the validator will correctly
accept bank notes. Clicking the ‘Start-up’ button will initialise the NV10 USB validator
and allow acceptance of bank notes.
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3.1.6 Preferences, Settings and Options

Options:
Innovative Technology Ltd  Validator Manager Yerzion 3.3.13
The general preferences for Fie | Tooks
. oolz Help
the Validator Manager o7 . Check Notes

software are accessible from
the ‘Tools” menu (as shown).
Click the ‘Options’ entry to )
open a new dia|og box: Set Walidator Options

Diagnostics

cctalk check

Set MWE Mag Head Type

MW 200 Bezel

&5 5P Options

By selecting the ‘Serial Port’ tab from the ‘Options’ dialog you can define which serial
port is being used to connect to the NV10 USB validator — click the *OK’ button to
confirm the setting:

Copions |
[ £35P Key ]
f cctalk Fey T Language ]
Senal Port T Slave Address

Click this arrow and then click on the
port you want to select as the default
from the drop down list.

)

Copyright © Innovative Technology Ltd 2014 k GA450-4
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The Validator Manager Software can detect the address used by the validator from the
‘Slave Address'’ tab:

| Options X
[ £55F Key )
f cotalk ey T Language
Serial Port )l Slave Address ]
Current program address: O Click this button to allow
Address | Status the Validator Manager
1] Found! software to interrogate the
1 Mot Found Find Slawe attached validator and
g? HE‘: ED””S Address determine the currently
al Faln
0o Mot Eound = set slave address.
83 Mot Faund |
a4 Mot Found 5 (ird - )
a5 Mat Found Slz:zea d'QrESS Click this button to cancel
8 Mot Found finding the slave address.
ar Mot Found
a8 Mot Found
a9 Mot Found
a0 Mat Found Set Program
312 Hut Euung address Click this button to set the
ob Foun lav r .
93 Mot Found slave address
94 Mat Faund
95 Mat Faund
| |+l

ak | Catizel |

After clicking the ‘Set Program Address’ ValidatorM anager X
button, a dialog box will appear confirming
the new setting - click the ‘OK’ button to

confirm the change.

Thiz program 55F addreszs haz now been set to

& CAUTION! The Validator Manager Software will only
communicate with the validator if the slave address

Limited slave address is set to 0, 1 or in the range 80-99.

ranges
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The ‘ccTalk Key’ tab allows the user to enter a six digit security key for use when the
validator is set for ccTalk operation.

Options |
r Serial Part Slave Address
[ 255P Key
cctalk Key: | Language i
| Enter the 6 digit key in this

box, and then click the
‘OK’ key to confirm.

2k, | Cancel

The ccTalk key is the HOST key, and is used for the ccTalk check — the validator must
be configured to use the same key.

& CAUTION! The user should make a note of the new key and

_ after any change. The default setting for the ccTalk
Take care when changing security key is 123456.
ccTalk key

Select the ‘Language’ tab to change the preferred language for the software. You
shouldn’t normally need to change the language setting, as this is determined
automatically based on the Windows locale settings. You can if you wish select one of
five specific languages (German, English, Spanish, Portuguese or Russian) if needed,
as shown below.

Click the ‘OK’ button to confirm the change — you will have to close and reopen the
software to allow the language change to take effect.
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Options |
[ Sernal Port Slave Address
[ e3P Key
cotalk Key T Language T

This is the default setting and
* Auto Select by LDCG"?Yl will not normally need changing.

i~ Deutzch i~ English
i~ Ezpafiol i Portugués
i~ Russian

Please restart Yalidator kM anager for changes to take effect

k. | Cancel

The final tab on the ‘Options’ dialog is the 'eSSP Key’ tab. By selecting this tab you
can set a new security key to use when the validator is operating in SSP mode.

Exercise care when changing the device eSSP key.
& CAUTION: The user must make a note of the new key and
change the host key to match. If the key is not
known then device must be returned to ITL for key
reset.

Take care when changing
eSSP key

The eSSP key is made up a string of hexadecimal characters - each part of the key
comprises two characters, giving a key with 16 characters in total.

As an example, your key may look like this:

65616d636f6e7375
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This key would be entered eight groups of two characters per group, like this:

65 61 6d 63 6f 6e 73 75

Options l
[ cohalk Key T Language ]
f Senal Part Slave Address
eSSP Key

£55P Host Key [Hex)

o o 'fo o ffo fo o o

/'

Enter the new hex security
key in these boxes, and
then click the ‘OK’ key to
confirm.

Dlﬁ\ Cancel

After entering the new key, press the ‘OK’ button to confirm the change.
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Validator Options:

NV10 USB validator specific options are accessed from the ‘Set Validator Options’ item

on the ‘Tools’ menu:

Innovative Technology Ltd  Yahdator Manager Yerzsion 3.3.13

File | Toolz Help

= .

Check Motes

cotalk check

Optiohg

Set alidator Optionz

Diagnostics

Set NYE bMag Head Tupe

Myw200 Bezel

&55F Optiohz

As with the ‘Options’ dialog, the ‘Set Validator Options’ dialog also has several tabs:

BY Target Settings for N¥39

>

Target Details

x|

|

General Optians

T Update Changes ]

Target Details

Target Data

I D ataset Settings I cctalk Settings I MDE Settings

Firmware Yersion
D ataset Version
Serial Murmber
Interface

N3 3231339 000
ELRDZEO4

1]
S55P

Exxit |

Aol Ehanges: |

The first tab ‘Target Details’ allow you to see specific details about the validator, and
provides a simple way of checking what version of firmware or dataset are currently
installed:
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Target Details ] Dratazet Settingz |

Target Data
Firrnware Werzion MW 33313393 000
D atazet Werzion EURDZE04
Senal Mumber 1]
|nterface S5P

There are no user-changeable settings on this tab.
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The second tab ‘Dataset Settings’ allows you to review and modify the settings of

each installed channel:

T arget Detailz

] Dataset Settings [

Select channel and then right click mouse button for options to change.

Options" tab].

i EURIZEDA Denomination
-2 Channel 1 [EUR 5] Pulses: 5 rkiplie
[ (&3 Channel 2 [EUR 10] Pulzes: 10 I1

[ (&3 Channel 3 [EUR 20] Pulzes: 20

[ (&3 Channel 4 [EUR 50] Pulzes: 50

Dratazet Inhibitz are unrelated to validator specfic channel Inhibitz [az zet on "General

Right clicking on a channel will open a further dialog allowing you to make specific

changes:

Select channel and then right click mousze button for optionz to change.

B EURDZE04 Denomination
e 2 R kAR ANt Change pulzes on Channel 1 [Eralli:hg]h';ulses: ]
F--E3 Channel 2 [EUR 10) Pulses:

[#----[E] Channel 3 [EUR 20) Pulses; Change denomination onChannel 1 [EUR 5] Pulzes: 5
F--E3 Channel 4 [EUR 50) Pulses:

Change country code on all channelz

Change Channel 1 [EUR 5] Pulzes: 5 to: »

Consult the Validator Manager Software help file for more information on how to

change channel settings.
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The third tab ‘ccTalk Settings’ allows you to review and modify the ccTalk settings and
also change the security key settings:

Target Details I Datazet Settings I I MDB &
Channel | D | RealValue Country | Multiplier | Dec |
1 ELI000G:, 05.00 EU 100 2
2 ELIOOT04 10.00
3 ELIO0Z20& 20.00
4 ELI00S0A, 50.00 . L . .
Click on multiplier or decimal point value to change.

cctalk Address [dec] ™ Use user key
|4D / cctalk default key |1 23456

. cctalk user key IDDDDDD
Check this box to allow

setting of a new user key.

Enter the new 6 digit
user key in this box.

& CAUTION! The user should make a note of the new key and

_ after any change. The default setting for the ccTalk
Take care when changing security key is 123456.
ccTalk key

The fourth tab ‘MDB Settings’ allows you to review and modify specific settings if the
validator is being used with the MDB protocol:

I Drataset Settings I cctalk Settings I

Parameater | Walue
Country Code 1978
Walue Multiplier 100
Dec Place 2

Click on parameter value to change.
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The fifth tab ‘General Options’ allows you to review and modify a variety of validator
specific settings, including interface mode:

Click these boxes to enable or disable
the Strim and Program Card Functions,
and whether the validator will issue
credit after a jam.

I

L||:n:|at¥

Check the box next to the interface mode
you want the validator to operate in.

ﬁ s

¥ Stim Function Enabled

! date, the interface will be:
erface |

A

[¥ Enable Program Card Function I
_ ; S5P [Smiley Serial Protocol)

[T Give credit after zafe Jam O  F4F (Paall

O PL1 [Pulse Mode 1)
[~ Dizable Escrow reject detection E E:;]T[[S;:-FLTSEHEII]
[100 Pulse high [ms] O DB [MultiDrop Bus]

[ | [ =L HIARIA|
|5|:| Pulze low [ms] — -
[ Fubse kil TheseT pulse tll_ﬂlng s_ettmgs are only

used if the validator is set to operate

ID Pulze low [mz) [Parallel) in Pulse mode.
S5P Address 1
|D / Specify the SSP address used by the
Yalidator Specific Channel Inhibits validator in this box.
1 g 1
I o o o Specific channels (denominations)
q 15 can be disabled by checking the | pisabe PSU Morier
ninlninininlnls appropriate box or boxes.

These inhibitz are validator zpecific and are unrelated to Inhibits zet in the datazet [as set on the "D ataset
zettings' tab). They will be prezerved if a new BY file iz downloaded to the walidator

Copyright © Innovative Technology Ltd 2014 t

The options shown in this area
will vary depending on the
interface type selected.

& WARNING!

Disabling the Strim Function is not recommended
Security risk because of the potential security risks.
[0] Information The Validator Manager software will only
Limited SSP address communicate with the validator if the SSP address is
ranges set to 0, 1 or in the range 80-99.
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The final tab, ‘Update Changes’ commits all the changes to the validator configuration
and updates the validator accordingly:

Y

*| This message indicates the |*Pdate Changes [
interface type being
applied.

After update, the interface will be:: S5P
[Smiley Serial Protocol]

Iﬁk

Block 0 af 3

This status bar indicates
the progress of the update
process.

Click this button to apply
all the changes and
update the validator.

L

) [ = kl

Information Please make sure that you click the ‘Apply Changes’

AI_ oy button, otherwise none of your configuration
BEYS Gl CEIEE changes will be applied or saved.
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After applying the changes successfully, a dialog box will
appear confirming the operation - click the ‘OK’ button to
confirm this and close the dialog box. The validator will

then be reset.

& WARNING!

Do not power off or
disconnect

eSSP Options:

35

Validator Manager |

\l") Changes complete...
b-'l.

Powering off the NV10 USB or disconnecting the
USB cable when updating settings can cause the
validator to stop working.

The 'eSSP Options’ menu item allows the user to change the fixed part of the SSP key
and other functions. Selecting this menu option will open a dialog box like this:

Click this button to enable SSP
encryption in the validator.

Yalidator Manager X]

.
\l) S5P encrpption mode haz now been set on this target

Click this button to disable SSP
encryption in the validator.

Yalidator Manager

‘EI) 55P encryption mode is now disabled on this target

—alidator eS5F Fey

Click this button to change the

ID_ ID_ ID— ID— ID— ID— ID— ID— ——  key in these boxes.

validator eSSP key.

YalidatorM anager

Enter the new eSSP

Set Key |

E st

o

Fized key succesfully changed to 0 0

After carrying out any of the operations on this dialog, the validator will be reset. Click

the ‘Exit’ button to close the dialog.
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3.2 Updating Firmware and Datasets

& CAUTION! Powering off the NV10 USB when updating the
firmware or dataset can cause the validator to stop
Do not power off working.

The NV10 USB validator firmware and dataset can be updated very easily using the
Validator Manager Software. The dataset files can be downloaded from the Innovative
Technology Ltd website:

Select Validator: [NWIUSE j Select Currency: |EUR - (Euro) j

Search |
Display #IEEI *I

<< Start < Prev 1 2 Mext = End ==

Page 1 of 2

Hame Code Issue Validator

Euro {20-50) ELURT1BO02 2 MWELISH @ =
Eura {5-10-20) MDB hultip ELRAZB02 2 MYELISH 08 5
Euro {5-10-20-50) ELURDZBO4 4 MWELISH 8 5
Euro {5-10-20-40) ELIRSERO3 3 MYELISH 08 5
Euro {5-10-20-50) ELRSER03 3 MWELISH @ (=
Eura {5-10-20-50-100-200- ELIR45815 15 MYELISH @ =
Eura {5-10-20-50-B-100) ELIRESBRO03 3 MWELISH @ =
Euro (B-B-5-10-20-50) ELIREOBO3 3 MwELISH @ =
Euraf10-20-507 ELIREYBO3 3 MwELISH @ =
Eurofaii-10¢5-20-507 ELRT4R02 2 MwELISH @ =
Eurafa{i-10-20-50) EURTZBOZ2 2 MWELISH @ =
Eurafs-107 ELIRD4B04 4 MYELISH @ =
Eurofs-10-20) EURTOBOZ 2 MWELISH 8 5
Eurofs-10-20) ELR10BO4 4 MYELISH 08 5
Eurofs-10-20-50) ELURT3BO02 2 MWELISH B 5
Eurofs-10-20-50) ELIRAYBR03 3 MYELISH @ (=
Eurafs-10-20-50-100) ELIRE3BO3 3 MWELISE @ =
Eurafs-10-20-50-100) ELIRE1BO3 3 MwELISH @ =
Eurofa-10-20-50-100) ELIRO3BO3 3 MwELISH @ =
Eurofa-10-20-50-100-200) ELIRS4B03 3 MwELISH @ =

e . The firmware and dataset files for the NV10 USB
I'o'l Information validator are combined into a single file, so both will
Combined data files be updated when you carry out the update.
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After selecting the dataset, a dialog will prompt you to save or open the file: select

the Save option

File Download ‘

Do you want to open or save this file?

& Mame: download.zip
Type: WinRAR ZIP archive

From:  www_innovative-technology_co_uk

Open Save | Cancel I

harm your computer. If wou do nat tust the zource, do not open or

@ whhile files from the Intermet can be uzeful, some files can potentially
zave thiz file. "wWhat's the nzk?

You can then choose where to save the file — choose a location that is convenient for

you:

Save Az

Save in: I@'Desktup j € 5 B R

':i by Computer
E by D ocuments
. by Metwaork, Places
E F2bit_BWInterface_Dirivers
= FIPS 1_4_5_mai

File name:

download j
j

Save az lype: IWinH.-i'-.H ZIP archive

Save I
Caricel |
o

Copyright © Innovative Technology Ltd 2014 k

GA450-4



NV10 USB Manual Set — Section 3 c}:]

Once the dataset file is saved, unzip the file and you can then start the process to
update the NV10 USB validator by connecting the USB cable and starting the Validator
Manager Software as described previously.

Innovative Technology Ltd  Yalidator Manager Yersion 3.3.13
Filz
Open Currency File

Toolz

Help

From the Validator
Manager main screen,
select the ‘Open a Open Firrrsare File
BV/NV200 file" entry
from the ‘File’ menu as BvN200 e meclfy
shown here:

Open a BW,

Currency Upload [MW7./8]

Drawwnload from Internet

E wit

You will then be prompted to select the dataset file you downloaded and unzipped
earlier — select the file and click the *Open’ button:

Open NY Firmware File 2| =

Laak it IE}dDwnlnad j € & g

EUROZB04_NYOOD

My Documents

Wi
-

by Computer

File name: IEUHDEED#_NVDDDEBEH 383000_IF_M j Open I
Filez of type: IE"J j Cancel |

[~ Open az read-only

o
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After clicking the ‘Open’ button, a new dialog box will appear. The status bar in the
bottom left hand corner of the dialog box will show the progress in loading the
dataset:

Program BY/NV200 file l

| =

Checking file intedgrity....

I se High Speed

Eragram [}

—

Once the dataset has been loaded, the file details will be shown in the status window,
and the two buttons at the bottom of the dialog box will be active - make sure that
you do not disconnect the power to the NV10 USB or remove the USB cable
until the programming operation has been completed. Click the ‘Program’
button to start the update process:

Program BV/NV200 file ||

File - C:“download ELRO2E 04_Nv00093351 333000_IF_01.be =l

Firrnware version - - NW0003 3.35.138 300
File checksum - CCFE - File checksum - CCFE

[+ Usze High Speed

Frogram | Cloze
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During the update process, the progress of the update will be shown in the status bar
at the bottom left of the dialog box, and the mouse cursor will change to an
hourglass:

Program BY/NV200 file l

File: - C:\dowrload ELRO2E 04_Ny00093351383000_IF_01 ke =l

Firrnware version - - NW0003 3.35.138 300
File checksum - CCFE - File checksum - CCFB

I se High Speed

Eragram [}

I— Block 32 of 79 Send update data

While the update process is being carried out, the NV10 USB bezel will flash when the
update is completed. After the update, the NV10 USB will be reset, and the dialog box
will then look like this:

Program BY/NV200 file l

File: - C:\dowrload ELRO2E 04_Ny00093351383000_IF_01 ke =l

Firrnware version - - NW0003 3.35.138 300
File checksum - CCFE - File checksum - CCFB

[+ Usze High Speed

Frogram | Cloze

I | Download Complete...

After the reset is complete, the NV10 USB validator will then be ready for use with the
new currency.
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3.3 Tools
3.3.1 Diagnostics
There is a dedicated software diagnostics tool for use with the NV10 USB validator

called ‘Bank Note Validator Diagnostics Tools’, and this software can be downloaded
from the Innovative Technology Ltd website:

Title Version File
Bank Mote Validator Currency Manager 3313 @ =
YRS (Validator Programming System) 1.0.16 @ =
SMART PIPS (Pay In Fay Out System) 145 @ =
=P Bank Mote Validator Diagnostics Tools 1.04 @
DAZ Drivers - 32 bit o @D
DAZ Drivers - 64 bit 1 0 5
BV Interface Driver Install - 32 bit 2 8 5
BV Interface Driver Install - 64bit 1 @ =
M4 Currency Manager 253 8 5

When the file download dialog box appears, click the ‘Save’ button and select a
suitable location to save the file in:
File Download |
Do you want to open or save this file?

@ Mame: |TLDiagnosticeT oolz104_mzi.zip
Type: WinRAR ZIP archive

From:  www_innovative-technology_co_uk

Open Save | Cancel I

e While files from the [nternet can be uzeful, zome files can patentially
@ harm your computer. If wou do nat tust the zource, do not open or
zave thiz file. "wWhat's the nzk?

Installing the Diagnostics tools software is done in the same way as the Validator
Manager software - Find the ITLDiagnosticsTools zipped file you just downloaded,
extract the installation file from the zipped file and double click the extracted file (it
has an .msi extension) — this will start the installation process.
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@ Set Program Access and Defaultz

After installing the software, you can run the
diagnostics software by selecting the
‘Shortcut to ITL Diagnostics.exe’ item near
the top of the Windows Start menu. Make
sure that the NV10 USB Validator is powered
up and the USB cable is connected before
starting the program.

The main screen of the diagnostics tools software looks like this:

< Innovative Technology Ltd - Diagnostics Tool - 1.0.4

File Optionz  Utiites  Help

)]

When running the software for the first time, you need to set a few options. These
are accessed from the ‘Options’ menu:
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< Innovative Technology Litd - Diagnostics Tool - 1.0.4
File | Options Utiities Help By selecting the ‘Serial Port’ item

from the ‘Options’ menu you can
ﬁ define which serial port is being

used to connect to the NV10 USB
validator. After selecting this
option, a new dialog box will open

allowing you to choose the correct
serial port.

= Serial Port

Select the required port from the dropdown list,
and then click the ‘OK’ button to confirm your
selection. This will close the dialog box and allow I N
you to select another option from the menu. You M
shouldn’t normally need to change the language Please select a serial
setting, as this is determined by the Windows
locale settings. You can if you wish select one of
four specific languages if needed, as shown
below:

port,

K Cancel

- Language =10] x|
=" Auto seleck by Locale
™ Deutsch " English

™ Espafiol " French

Please restart the Diagnostics Tool for
changes to take effect.

Cancel |
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+. Innovative Technology Lid - Diagnostics Tool - 1.0

File Optionz | Ltlities Help

4

L.

44

Select the ‘Diagnostics’ item from
the ‘Utilities” menu to start the
diagnostics process (you can also
start the diagnostics by clicking
on the left hand icon below the
menu bar) - this will open the
Diagnostics screen:

. Diagnostics x|
Sensar | Skaktus Makor | Skaktus
1] 1+
Make sure the equipment is ON
and connected before starting
diagnostic.
Skart Diagnoskic
1| | » O, | Save Zancel

Click the ‘Start Diagnostic’ button to start the diagnostic process. The software will
then prompt you to insert a special piece of green diagnostics paper (ITL part number
LB149). Insert the paper in the same way you would with a bank note — at the end of

the diagnostics test the paper will be ejected.
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Diagnostics Pass:

A summary of the validator type and Motor test results are shown in
related information is displayed here. this window.
« Diagnostics I

Sensar | Skaktus \ \ Makor I Status‘
%2 Ly Reflected 200 o Mokar Fwd o]
#4 U Reflected 200 (a8 Maokor Rey (a8
#1 IR Reflected 200 (a8 Stacker (a8
%3 IR Reflected 200 Ok
%2 IR Reflected 200 oK = | 5]
%4 IR Reflected 200 Ok
%1 Red Reflected 200 (a8
%3 Red Reflected 200 (a8
%z UV Through 200 8] Type MO
s LY Through 200 Ok Serial Mb. 2817023
#2 IR Through 200 Ok Firmware Yer, NY90333 1332000
#4 IR Through 200 (a8
%1 Red Through 200 (a8
%3 Red Through 200 (a8
Card Read MY 1 (a8
Zard Read MY 2 (a8
Frank Ok
Skart (o] 4 PASSED
Rear Flag (a8
Roller one (a8
Stacker Home (a8
Stacker Opto (a8
Drive Opko 0K, The overall test result is displayed here.
Maokor Stacker Full (a8
P5U Manikar Ok
Rear_Moke Detect Ok
MF_Sleeper (a8
MNF_Maoke_Detect oK Start Diagniostic
MF_Makor _Current Ok
Lens Posikion 1 Ok
Lens Posikion 2 Ok
1| | » O, Save Zancel

[\

Sensor test results are shown in
this window.
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Diagnostics Fail:

) Motor test results are shown in
A summary of the validator type and this window — in this example all
related information is displayed here. the motors have passed testing.

= Diagnostics |

Sensar | Status\ \ Makor I Status‘

%2 Ly Reflected 200 o Mokar Fwd o]
#4 U Reflected 200 (a8 Maokor Rey (a8

#1 IR Reflected 200 (a8 Stacker (a8

%3 IR Reflected 200 Ok

%2 IR Reflected 200 0K . | 5]
%4 IR Reflected 200 Ok

%1 Red Reflected 200 (a8
%3 Red Reflected 200 (a8

#2 L Through 200 (a1 wpe MO

#4 ¥ Through 200 QK Serial Wb, 2817023

#2 IR Through 200 oF. Firrweare Yer, NY303331339000
#4 IR Through 200 (a8

%1 Red Through 200 (a8

%3 Red Through 200 (a8

Card Read MY 1 (a8

Zard Read MY 2 (a8

Frank Ok

Start Fall FAILED
Rear Flag FaIl

Roller one (a8

Stacker Home (a8

Stacker Opto (a8

Drive Opko 0K, The overall test result is displayed here.
Maokor Stacker Full (a8

P5U Manikar Ok

Rear_Moke Detect FAIL

MF_Sleeper FaIl

MF_Mote Detect FAIL Stark Diagnoskic
MF_Makor _Current FAIL

Lens Posikion 1 FAIL

Lens Posikion 2 FAIL

1| | » O, Save Zancel

/
/

Sensor test results are shown in this
window — in this example, several sensors
have failed during the diagnostics test.

Further details on how to use the diagnostics tools and interpret the results can be
found in the program help file.
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3.3.2 Connections

The NV10 USB Validator has a single connector that is used to allow interfacing and
programming.

Information
Power is always required on pins 15 and 16 of the

Power always required 16 way connector.

regardless of connection

type.

The connector is a 16 pin socket located on the side of the validator head. This
connector is used to interface the NV10 USB to the host machine. The pin numbering
of the socket is shown below, as well as an overview of the socket connections:

Interface Socket

1 — 15
O0OO0OO0O0O00O
O0OO0OO0O0O00O

2 16

Pin Description
1 Serial Data Out (Tx)
5 Serial Data In (Rx)
11 USB Data +

12 USB Data -
13 USB Power (+5V)
15 +V

16 0V / Ground Connection

To use a USB connection with the NV10 USB, a USB cable with a 16 way connector on
one end (ITL Part Number CN392) should be used. The CN392 cable fits into the 16
way connector and allows high speed programming and serial communications when
used in SSP, ccTalk and SIO modes.
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When using the USB connection, power must be supplied to the NV10 USB using the
CN392 cable.

The socket connections for the natively supported protocols are shown in the tables
below, as is a summary of the interface units needed for other types of operation:

& WARNING!

Risk of unit damage

NV9 USB SSP Interface:

Do not make any connections to the interface socket
pins marked ‘Do not connect’ — making connections
to these pins could cause severe damage to the unit.

Pin Name Type Description
1 Vend 1 Output Serial data out (Tx)
2
3 Factory use only Do not connect
4
5 Inhibit 1 | Input Serial data in (Rx)
6
7
8 Factory use only Do not connect
9
10
11 USB D+ Data USB Data +
12 USB D- Data USB Data -

13 USB Vcc Power USB +V (+5V)
14 Factory use only Do not connect
15 VIn Power +V

16 GND Ground GND
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NV10 USB ccTalk Interface:

49

Pin Name Type Description
1 Vend 1 Output Serial data — m_ust also be
connected to pin 5
2
3 Factory use only Do not connect
4
5 Inhibit 1 Input Serial data — m_ust also be
connected to pin 1
6
7
8 Factory use only Do not connect
9
10
11 USB D+ Data USB Data +
12 USB D- Data USB Data -
13 USB Vcc Power USB +V (+5V)
14 Factory use only Do not connect
15 VIn Power +V
16 GND Ground GND
NV10 USB SIO Interface:
Pin Name Type Description
1 Vend 1 QOutput Serial data
2
3 Factory use only Do not connect
4
5 Inhibit 1 | Input Serial data
6
7
8 Factory use only Do not connect
9
10
11 USB D+ Data USB Data +
12 USB D- Data USB Data -
13 USB Vcc Power USB +V (+5V)
14 Factory use only Do not connect
15 Vin Power +V
16 GND Ground GND
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NV10 USB Pulse Interface:

Pin Name Type Description
1 Vend 1 Output Credit pulse stream output
2
3 Factory use only Do not connect
4
- Inhibit Channel 1 by holding this
5 Inhibit 1 Input bin HIGH
- Inhibit Channel 2 by holding this
6 Inhibit 2 Input bin HIGH
- Inhibit Channel 3 by holding this
7 Inhibit 3 Input bin HIGH
- Inhibit Channel 4 by holding this
8 Inhibit 4 Input bin HIGH
Busy signal — output is pulled
2 Busy Output low when the validator is busy
Enable Escrow function by
10 Escrow Input holding this pin LOW
11
12
13 Factory use only Do not connect
14
15 Vin Power +V
16 GND Ground GND

When operating in Pulse mode the NV10 USB outputs a number of pulses on Vend 1.
The number of pulses for each channel is different and set to default values within the
dataset. The number of pulses and the pulse duration can be modified using the Bank
Note Validator Currency Manager Software, and a maximum of 16 channels can be
used.

NV9 USB Multi Drop Bus (MDB) Interface:

MDB is a serial bus interface commonly used in electrically controlled vending
machines. This is a 9600 Baud Master — Slave system where the NV10 USB validator
is a slave to master controller.

To use the NV10 USB with MDB protocol, an IF5 external interface convertor is

required. The IF5 regulates the power supply and opto-isolates the communication
lines. The NV10 USB validator supports the MDB Protocol Version 1, Level 1.
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NV10 USB Parallel Interface:

51

Pin Name Type Description
1 Vend 1 Output Channel 1 credit, 100ms active
low pulse
5 Vend 2 Output Channel 2 credit, 100ms active
low pulse
3 Vend 3 Output Channel 3 credit, 100ms active
low pulse
4 Vend 4 Output Channel 4 credit, 100ms active
low pulse
- Inhibit Channel 1 by holding this
5 Inhibit 1 Input bin HIGH
- Inhibit Channel 2 by holding this
6 Inhibit 2 Input bin HIGH
- Inhibit Channel 3 by holding this
7 Inhibit 3 Input bin HIGH
- Inhibit Channel 4 by holding this
8 Inhibit 4 Input bin HIGH
Busy signal — output is pulled
e Busy Output low when the validator is busy
Enable Escrow function by
10 Escrow Input holding this pin LOW
11
12
13 Factory use only Do not connect
14
15 VIn Power +V
16 GND Ground GND

When operating in Parallel mode the NV10 USB will issue a 100ms active LOW pulse
on the relevant vend line, and a maximum of 10 channels can be used. There is also
the option to use a binary output where the NV10 USB will output a binary pattern on
vend lines 1 — 4. Binary mode can be set as an option using a configuration card or
with the Bank Note Validator Currency Manager Software.
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3.4 Frequently Asked Questions
a. Why are there no DIP switches on the unit?
e The NV10 USB has no dipswitches. The unit is configured with the

configuration button mounted on right hand side of the unit — see subsection
1.3 of this manual for more information.

b. Are 64 bit drivers available?
e Both 32 and 64 bit drivers can be downloaded from the ‘Support’ section of the

ITL website — please make sure that you are using the correct type of driver for
your Operating System.

c. Some or all notes are not accepted
e Check that no inhibits are set in the Validator Manager Software (see

subsection 3.1 of this manual). If the problem persists, contact ITL Support for
further assistance.
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MAIN HEADQUARTERS Innovative Technology Ltd
Derker Street — Oldham — England - OL1 4EQ

Tel: +44 161 626 9999 Fax: +44 161 620 2090
E-mail: support@innovative-technology.co.uk
Web site: www.innovative-technology.co.uk

' AUSTRALIA
j support@innovative-technology.com.a
» Innovative Technology 'S'PPrt@nnovativ gy.com.au

INTELLIGENCE IN VALIDATION
BRAZIL
suporte@bellis-technology.com.br

CHINA
' support@innovative-technology.co.uk
o Bellis Technolo
INTELLIGENCE IN VALIDATgNy GERMANY

supportDE@innovative-technology.eu

ITALY
supportIT@innovative-technology.eu

SPAIN
supportES@innovative-technology.eu

UNITED KINGDOM
support@innovative-technology.co.uk

REST OF THE WORLD
support@innovative-technology.co.uk
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